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Note: There is more help and instruction available within the RUSLE2 Program
by clicking on the "Help" menu and selecting "users manual". For help with an
individual cell in the program, place your cursor on that cell and right-click, then
select “Help™.
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The following are the steps needed to install RUSLE2 and install the Climate,
Soils, and Management databases.

Step #1 — Create a “RUSLE2” Folder

Create a folder in your C directory or in the My Documents directory and call it: RUSLE2
Archive Folder. This can be used now and in the future to store all the RUSLE?2 files for later
import and export files. This separate directory is optional, as the C:/Program Files/usda/rusle2
directory where RUSLE?2 will be loaded can also be used .

Step #2 — Download Program and Databases or copy from CD

A. Go to the website http://fargo.nserl.purdue.edu/rusle2 dataweb/RUSLE2 Index.htm. This
site contains the “official” NRCS version of RUSLE2 to download and the official NRCS
databases to download and use. If available on a CD, simply copy the files from the CD to
the RUSLE2 Archive Folder ) (or other file folder) that you created in Step 1.

B. Download the following from the above website and save it in your RUSLE2 Archive
Folder:

a) The RUSLE2 program (Click on the Download File under RUSLE2 Program File)

b) The NRCS Base Database, if this file is not included in the RUSLE2 Program
download (Click on the Download File under NRCS Base Database)

c) The Climate Database for your state. (Click on the Data Files under CLIMATE)

d) The Crop Management Zone files (e.g. CMZ 16) that covers your respective work
area. If you are not sure which CMZ you need Click on the “Maps” under CROP
MANAGEMENT TEMPLATES. Then download by clicking the “Crop
Management Zone” link under Crop Management Templates).

e) The Soils database for your state. After you download you will need to unzip the
Soils Folder for your state. Unzip (extract) the soils folder to the same file folder.
NOTE: you will need to double click on the state folder to open the folder to select
your county database.

Step 3. Installing RUSLE2

A. Logon as administrator. You need the administrator’s password or have someone with
administrative privileges do this for you. For more detailed instructions on installing
RUSLE2 download RUSLE2 Installation Guide (3.6 mb) at the following site (in Adobe
Acrobat format): http://fargo.nserl.purdue.edu/rusle2 dataweb/RUSLE2 Program.htm

B. Navigate to where you downloaded and saved the RUSLE2 program (RUSLE2 Archive
Folder) and databases using Windows Explorer. NOTE: For a standard installation on
NRCS CCE-compatible machines, select all defaults during installation.

a. Double-click on the R2ZNRCS installer line
b. On the Setup — Rusle2 screen, click Next.

c. The next Setup — Rusle2 screen is a license agreement. You must click the button for
I accept the agreement to proceed. Click Next.
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d. The next Setup — Rusle2 screen asks for User Information. Providing your User
Name and Organization will help identify the user when bug reports are sent to the
Univ. Tennessee programmers. This information also identifies the user on Print
reports. This information is not mandatory but is helpful. Please fill it out. Click
Next.

e. The next Setup — Rusle2 screen selects the Destination Directory, where RUSLE2
will be installed. On NRCS computers this will be the USDA subfolder under
Program Files. Highlight the USDA folder. Click Next.

f.  On the next Setup — Rusle2 screen, you select components to be installed. Full
installation is recommended, and should be highlighted. Click Next.

g. The next Setup — Rusle2 screen is the Select the Start Menu Folder. Highlight
USDA Applications/Rusle2. Click Next.

h. The next Setup — Rusle2 screen is Select Additional Tasks. Y ou may wish to Click
the button for Create a Desktop icon to place the RUSLE2 icon on your Desktop
screen and/or Click the button for Create a Start menu icon to place the RUSLE2
icon in your Start menu. NOTE: If the administrator login is used to install the
program these icons will be placed on the administrator’s desktop screen, not on the
normal user screen. You will need to create the shortcut later after you have logged
back on as the normal user. Click Next.

i.  The next Setup — Rusle2 screen, Ready to Install lists the settings you have chosen in
previous screens. After reviewing, click Install.

j. The RUSLE2 program will be installed in the directory, Program Files/usda/Rusle2.

C. Log off as administrator and logon as yourself.

Step 4. Create a RUSLE2 Desktop Shortcut (OPTIONAL)

Open Windows Explorer. Navigate to C > Program Files > USDA > RUSLE2 > Binaries. In the
Binaries file highlight then right click on the RUSLE.exe file. From the menu select Send To >
Desktop (create shortcut).

Step 5 — Import Databases For Soils, Climate, Crop Management Zone Files
1* - Open the RUSLE2 Archive Folder where you saved the Soils Database, the Climate
Database, and the Crop Management Zone (CMZ) files.

2" _ Copy the climate database file in your RUSLE2 Archive Folder and paste it into the
"Import" folder in the C:/Program Files/usda/RUSLE2/imports folder. This is where the
RUSLE?2 import utility will look for this file. Repeat this process for the county(s) soils database
files desired and the CMZ database(s).
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3" - Download the import instructions and follow the instructions to import the databases into
RUSLE2 for your specific use @
http://fargo.nserl.purdue.edu/rusle2 dataweb/RUSLE2 Instructions.htm

4™ — Open the RUSLE2 Program
A. You can open the RUSLE 2 program by clicking on the RUSLE?2 icon on the
Desktop.
Or
B. Click on Start > Programs > USDA Applications > Select RUSLE2

5™ - Go to the Database Menu - Select "Import with templates, access...."

DATABASE:
This is one of the most often used menu
items.

The main items used here will be:
e Import with Templates, access...
e Export with Templates, access...

A. This is the menu used to import your climate, soils, and Crop Management Zone
databases.

B. Follow the import instructions you downloaded @
http://fargo.nserl.purdue.edu/rusle2 _dataweb/RUSLE2 Instructions.htm to import the
climate, soils, and Crop Management Zone databases.

C. DO NOT import more than 6 County Soils Databases into RUSLE2. Installing
more than 6 soils databases can slow down your RUSLE2 computer processing time.
Click on the Data Files under SOILS and download the desired county soil
databases.

D. After the databases are imported into RUSLE2 you are now ready to use the software to
predict and evaluate sheet and rill erosion.
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Using RUSLE2 - Introduction

Step 1. Start the RUSLE2 program.

In the introductory screen select the "Plan Description Worksheet" users template (the green
leaf). This is the screen that can be used to calculate soil loss for multiple fields and print a
summary report. We will use the "Plan Description Worksheet" template to provide instruction
on how to RUSLE2. The other worksheets follow a very similar process.

Blusteovesonrebzooons L RS |

File Database Edit “iew Options ‘window Help

| W %) B | < o] el el i ¢ e O il A g b e BBV Auoupdate

Plan Description/ Worksheet View Profile View (Green
View (Green (Data Sheet) Sloping Line)
Leaf)

Plan Description View (Green Leaf) - This is the template to use to calculate soil loss on
multiple fields.

Worksheet View (Data Sheet) - This is a useful template to use to calculate several soil loss
alternatives for one hillslope or one field.

Profile view (Green Sloping Line) - This template is used to make a single calculation of soil
loss for one hillslope in a field.

Note: This is also the template you will need to use if you want to build rotation management
systems that you may wish to use on a frequent basis, save them to you local CMZ file folder,

and use in the future to save entry time.

Step 2. Select a Starting File.

In the "Open Objects From Plan" dialogue box click on the file you wish to start. If you are
starting for the first time [select the default]. Make sure you click hard enough that the [file
name] appears in the name blank at the bottom of the dialogue box. Click Open.

Step 3. Owner Name or your Client.
Click on the drop down arrow. A box will appear where you can type in the clients name.

Step 4. Location.

Click on the drop down arrow. Navigate down the files, open your state, then move down and
double click on the county or climate file you want.
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Step 5. Save this Template (Optional)

At this point, or anytime after this, you can save this template/management system so you can
later start with this template. The location you selected will already be entered when you open
the template.

Click FILE > SAVE AS >
In the name blank of the dialogue box type in a name you would like to call this template. Click
Save. This is now saved for future use.

Now Click on the "Options" menu at the top of the screen. Select Template > Edit Current.

In the " Startup Tab ", check the box next to "use this template on startup" if you want this one to
start when you open the "Plan Descriptions Template". If not do not check it.

In the "General Tab" click "Highlight Selected Tab" and "Show Calendar..."

Click OK

Step 6. Info Box (Upper-Right of Screen)

Place your cursor in the box and type a description of the fields or treatment units being

evaluated. This will be helpful information for the future. The information entered here will
appear in the Report Printout that will serve as you permanent record.

Step 7. Enter Fields and Field Names (Plan View)

ZARUSLE2 Version Feb 20 2003 - [Plan: Franklin2] || o | 2| =) 2| &) )| EEELR]
3{:3— File Databaze Edit ‘iew Options ‘Window Help - ﬁllﬂ

HES R0 809003 /ANE $ w0 @ s b o B S|P oo ‘
/

Owner name John Doe
Location [ TV rankin Courty 7

Info | Type information here about the farm or treatment units being evalygled. ;I
Thiz information will appear on pour "Flan Summary Beport”

=

[P PERTENEERY | Corpute 2 soi loss for a field/watershed |

List of fields fu] Selected alternatives for fields
Field _ . Conz. plan. S_ed.
Field name Field name Drescription sol loss,  delivery,
+ | - t/acur t/aciyr
...ksheet 1 1 Fall Mulch Till for Com and Soybeans, NT wheat 2.32 2.32
...ksheet 2 2 Fall Mulch Till Twisted Shanks for Carn, NT Soybeans and 'Wheat 467 467
sheet 3 3 Fall Mulch Till Corn, Corn Silage, Wheat, 3 years Altalia 24R 248
_ksheet 4 4 NT Com-SayB Raotation Using the Aerway 446 4 46

Click the + sign to add fields and the- sign to delete fields. To delete, highlight the
worksheet/field row then click on the - sign.

Type in the field names/numbers. After you move to the next cell the field name/number is
transferred to the right side of the screen (Selected Alternatives for Fields).
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Step 8. Open the "Plan" view for a Selected Field and Enter Data.
Click on the "yellow folder" next to worksheet on the far left (next to where to type in the field
name). This will open the worksheet view where you can enter data for that field.

Soil - Use the drop down arrow to navigate to the county soil database. Double-click on the
county file to open the soil list. Then move down then down to the soil map unit that best
represents the field being evaluated. Double-click on the map unit to enter. Note. You will need
to click on the + sign next to the soil to open that folder. Some map units have more than one
component and you will need to select the map unit component that best fits your field situation.

Slope Length (Horz) ft. - Type in the measured length of slope (e.g. 150).

Avg. Slope Steepness % - Type in the measured slope % ( e.g. 6).

This is the Field Worksheet View after clicking on the Yellow Folder for Field #1.

EARUSLE2 Version Feb 20 2003 - [Plan: Workshest (Field[1]) of Franklin] B | or | 2 =1 2 | Q)| € EELE
== File Databaze Edit Mew Option: ‘Window Help = ﬁ‘lﬂ
HE G o o8003 QBN ¢ w4 by ® e B8 F awowpdas !
" 3 —
o " B Go to "Help Adding or
Llwhier name g g "
ST : Deleting Attributes" for
— | more detail on this
Compare management alternatives for a single hillslope profile | EaeeE TR ore 0t Ll e =R s (= | feature.
Laocation Slope Topoaraphy ]|
Soil[T. lopeshAlexandria silt loam 90% T walue, tac/yr| 5.00 Seqment  Steephess Hoiiz |
Slope length [hariz), ft 150
Avg. glope steepness, % E.00 Some Of the "attribute"
columns can be removed if
not needed
__Management alkemnaive Fable ]
Temp. Rotation Isthiza  Adjust res. . . Adjust est. Adjust rack . Strips/barrie Diversion/ % in . Surf. res. Detachm
SCENario Base management builder rotation?  burial level Adjust vields res, cover Contauring s rmace. pu— Description cov. values N zlope
+ - : additions sediment : . tiacdy
[ Prefile ... rear CropshCom arain, FMH 2. builder  “Yes .= burial ™[ | Yields [ J...inputs[ ... cover[ |..cent™ [none] ¥ inone] =  ¥es | [ .. cover] 280

Yellow Folders - Click on the Following "yellow folders" (attributes) to do the following:

Note: some objects on your screen may differ from those shown in the example above. Screen
views can be modified to meet the needs of the user. The NRCS national RUSLE2 leaders will
work with you to design screens that meet your needs.

Profile - Clicking here will open up the Profile view to calculate soil loss for the field - it is just
a different view to do the same thing as on the worksheet above. User's Choice.

Base Management - Click here to select your first crop in the rotation, or to select a saved
Management file containing an entire rotation. Use the drop down menu under "Base
Management" to select the crop/tillage system or rotation. Be sure to navigate to the correct
CMZ if you have more than one CMZ in your RUSLE?2 database.
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Rotation Builder - Click here to open the rotation builder to add or subtract crops and
management for the desired rotation. When the "rotation builder" screen opens you click the +
sign (under Man. On the far left side) to add a row for each crop in the rotation. If you enter too
many or need to delete a row, highlight the row and click the - sign.

Select the desired crop for each year. The starting and ending dates for each crop are shown next
to the crop. EXTREMELY IMPORTANT: make sure the starting date for the following crop
is at least one day later than the ending date for the previous crop. Problems may occur, if for
instance, you plan to plant a fall seed crop after corn grain and the harvest date for the corn is
October 20 and the planting date for the wheat is October 10. You can use the "correct dates"
feature to change dates if needed. In most cases the program will make the adjustments for you.
The dates of all the operations and crops will appear on the far right of the "rotation builder"
screen. Generally the user should not need to make edits on the right side of the screen. If
changes to a field operation are needed you can make those changes on the far right.

Click "Apply" or "Apply and Close" when finished building the rotation. You will be given the
opportunity when closing to name this rotation and save it to the "temporary Management file".
Give the rotation a descriptive name and click OK.

Is this a rotation? Select YES if this is a rotation in which the crop(s) and operations are
repeated in cycles, or NO if it is a single crop or management scenario such as with construction

sites.

Adjust Residue Burial - Click here to open a choice list to decrease burial or increase burial rate
for each field operation.

Adjust Yields - Click on this folder to enter the planned yield level for each crop.

Adjust Ext. Residue Additions - Click here to add “external” residue to a management system,
e.g. adding manure or mulch.

Adjust Rock Cover - Click here to add the percent of the surface that meets the rock cover
criteria (see the section “Help Rock Cover - Guidelines for Estimating Rock Cover in the
Field” below).

Contouring - Click here to select the appropriate contour type (if applicable). The default is up
& down the hill.

Strips/Barriers - Click here to select the appropriate barrier type (if applicable). The default is
none.

Diversion/Terrace - Click here to select the appropriate diversion/terrace type (if applicable).
The default is none.

Show in Summary - Select YES to have the results shown on the Plan view screen (previous
screen) and your Word file or printout report.
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Description - Type in a short description of the rotation system. The results shown on the
Summary (previous Plan view screen) and your Word file or printout report.

Surface Res. Cover Values - Click here will view results of how much residue is remaining
after each field operation.

Detachment on slope t/ac/yr: Actual soil loss detachment on the slope ("L").

Soil Loss in the Eroded Portion: Soil loss on "L" with deposition subtracted due to complex
slopes or depositional strips.

Soil Loss for Cons. Plan: This is the soil loss value to use for conservation planning.

Sediment Delivery - Soil loss delivered to the base of the "L". It is the total soil loss minus any
detached soil (if any) that has been deposited on the hillslope ("L").

The Worksheet Template

The "Worksheet" view is similar and operates the same way as the "Plan" view screen above.
Start with the Worksheet view when you want to do multiple alternatives for just ONE field,
using a single slope length and steepness.

How to Save a Rotation for Future Use
Open the Profile view to change the view for the Profile view do the following:
1**. From the Worksheet view click on the yellow folder next to "Profile" (far left side of screen);

or if not in the Worksheet view, click on the Profile icon on the top of the screen (the green
sloping line).

%?EJHUSLEZ Yersion Feb 20 2003 - [Plan: Profile [Temp. scenario[1]] of Franklin*]

i File Datshase Edit Wiew Options 'Window Heln ,2“‘1. After the Profile view is open click on the
HE e o ol 0ANH ! wld2L "Options Menu", select "Template", select "Open"
Lot e eonot The following dialogue box will appear. Select
| Lokin ]y Ve 8 5EE G your desired Profile: "NRCS Simple" is generally

E Franklin.=ml .
1 . sl
59 NACS advanced 022003 sl sskes the easiest to use.
1 |2 NRCS advanced WWRR 0220035ml lem
, LS s 2003 rd . . " "
[NACS summary 022005 ol —— 3. Select your choice and click "Open".
- E MRCS summary NWHR 022003.=ml
Starti
date,
r A7
[ File name: |NF|CS simple 022003, xral Open I
Files of type: IUser templates j Cancel |
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From the Simple Profile Template, do the following to save a Rotation and Tillage
sequence. This process can also be used to save a single crop/tillage system.

1%, In Step 4a Base Management - Select either an existing rotation that may be in the temporary
folder or add the first new crop for a new rotation form your CMZ.

2" Click on the "yellow folder" for the Base Management. This will open screen where you
can build the rotation.

3" Click on the "yellow folder" for "Rotation builder for this rotation".

4™ Build your desired rotation with the crops and management desired. Make sure the dates for
the ending of one crop is prior to the date of the start for the next crop. Make adjustments to the
dates as needed using the "Correct Dates by" drop down menu.

5™ Click Apply/ Close on the Rotation Builder Screen.

6™. On the screen that is now open you can change the yields to fit your situation.

7™ Click the "SAVE AS" menu button or select "SAVE AS" from the File Menu. Use the
yellow arrow in the upper left corner of the dialogue box and navigate to the CMZ you wish to
save the file. IMPORTANT - Save in the local folder. Type in a file name for the crop or
rotation and click SAVE.

You can now use this Management file for any future use where is it appropriate.
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Help: Printing and Saving Reports

After the user has completed data entry and the results are displayed in either the Worksheet,
Plan view, or Profile view the user can print the results for viewing and save as a permanent
record. The record can be saved as a Microsoft Word (.doc) file anywhere in your file directory.
For NRCS and Conservation District users it is suggested you save the file in the client's folder
within the Toolkit directory.

To Print the Results, do the Following:
1°. Click on the FILE menu. Select Print to MS Word Template.

2", After the dialogue box appears select the appropriate template.
¢ NRCS RUSLE 2 Management Record.dot

¢ NRCS RUSLE 2 Plan Record.dot

¢ NRCS RUSLE 2 Profile Record Expanded.dot

¢ NRCS RUSLE 2 Profile Record.dot

¢ NRCS RUSLE 2 Worksheet Record.dot

3", Click "OPEN" in the dialogue box. This will open MS Word and display your record of the
results.

4™ At this point you have the option of printing and/or saving the document in your file
directory. The next page shows an example printout of the four fields used in preparing these
instructions.

5™, If you want to save this RUSLE2 run, click the FILE menu and do a SAVE AS. Giveita

unique name and SAVE. One should not do this very often as it will take up memory space and
could reduce the speed performance of the RUSLE2 program.
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RUSLE?2 Erosion Calculation Record

Owner name: John Doe

Info: Type information here about the farm or treatment units being evaluated. This

information will appear on your "Plan Summary Report".

File: plans\Franklin
Access Group: R2 NRCS FId Office

Inputs:
Location: Franklin County
Results:
Field name Description Cons. plan. Sed. delivery, t/ac/yr
soil loss,
t/ac/yr
1 Fall Mulch Till for Corn | 2.32 2.32
and Soybeans, NT
Wheat
2 Fall Mulch Till Twisted | 4.67 4.67
Shanks for Corn, NT
Soybeans and Wheat
3 Fall Mulch Till Corn, 2.46 2.46
Corn Silage, Wheat, 3
years Alfalfa
4 NT Corn-SoyB Rotation | 4.46 4.46
Using the Aerway
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Help: Rock Cover - Guidelines for Estimating Rock Cover in the Field

Introduction: The RUSLE2 computer program has an input box on the Profile view screen for
“Rock cover, %”. This document offers guidelines for making estimates in the field for the
percent cover from rock, rock fragments, or coarse fragments. Coarse fragments on the soil
surface effect the Cover and Management factor in RUSLE2. Rock cover does not effect the
Soil Erodibility factor.

Caution - Use Good Judgement: Research data shows that the presence of rock cover can
significantly reduce soil erosion, and the RUSLE2 model accounts for this effect. However,
users should be cautioned to exercise good judgement when developing conservation planning
alternatives that reflect the presence of surface rock fragments. For example, a rock cover entry
in RUSLE2 that reduces soil loss to acceptable levels should be re-considered if the hillslope
shows clear evidence of severe, active erosion.

Guidelines for Estimating Rock Cover in the Field

Minimum Size Requirement: Count rock fragments that are larger than 10-mm (0.3937 in, or
2/5 in). On undisturbed land in the western U.S., count rock fragments that are larger than 5-mm
(0.19685 in, or 1/5 in). Professional judgement is needed when rocks are flat or light in weight.
The defining criteria are whether it is easily moved by runoff during a storm event.

NOTE: States should develop practical field measurement guides for minimum size
requirements of rock fragments. Field users should be encouraged to use (or should be given) a
practical tool for use in measuring the 10-mm or 5-mm size. This could be a drill bit, stove bolt,
plastic ruler or a paper scaled-drawing. For the 10-mm size, the minimum size rock should be
slightly larger than a 3/8-in drill bit, or slightly smaller than a %2-in drill bit; and for the 5-mm
size, the minimum rock size should compare with the '4-in drill bit. Where rock fragments are
flat, a conversion should be developed at the state level, since the 10-mm and 5-mm size in these
requirements are meant to apply to a more rounded or blocky shape. Dimensions for flat rock
measurement should take into account comparable weight of blocky or rounded rock vs. flat
rock, keeping in mind the ability of the flat rock to remain in place and reduce runoff during a
storm event.

Most Erosive Period: The estimate of rock cover should represent the range in rock cover over
the 3 or 4 month period that is most erosive. “Most erosive” should include consideration of
both the period of highest rainfall erosivity and the vulnerable management period. Since field
measurements cannot always be made during this period, additional guidelines may need to be
issued by the state.

Measuring Rock Cover: Whenever possible, measure rock cover using the line-transect
method.

Rock Cover on Entire “L”: The percent rock cover should be based on the entire eroding
hillslope profile, or "'L". We are evaluating soil loss on the entire RUSLE2 hillslope profile.
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Avoid overestimating the rock cover based on a segment of the slope that contains the largest
percent of rock cover.

Represent Field or Portion Thereof: Adjust the rock cover estimate to represent the field or
portion of the field represented by the hillslope profile if rock cover is significantly more or less
on the representative hillslope compared to the rest of the field.

Ignore Overlap with Residue: When measuring or estimating rock cover, ignore any overlap
with residue cover. Count the surface rock cover even if it lies above or below residue. RUSLE2
takes into account the overlap of different types of ground cover. For example, if rock cover is
15% and corn stalks provide 40% cover, the total cover considered by RUSLE2 is 49%.
RUSLE?2 properly takes into account the nonlinear mathematics of the combination of rock cover
and crop residue.

NOTE: This User’s Guide for the RUSLE2 program was created by Norm Widman,
Conservation Agronomist, USDA-Natural Resources Conservation Service, Columbus OH.
From a draft created primarily for users in Ohio, this document has been modified for all users of
the official NRCS version of RUSLE2. Editing has been done to Norm’s document in an effort
to improve its usefulness to all users. gaw 03/05/03.
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